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1Lawson Fashion PLM Workflow

Overview
Increase visibility and manage key milestones throughout the product lifecycle with Lawson Fashion
PLM Workflow. By focusing on exception management, Lawson Fashion PLM Workflow helps all parties
coordinate, share, manage, and track all pre-production, manufacturing, and delivery activities. Reduce
costs, speed products to market, and ensure every order is profitable.

You manage more styles and orders today than ever before. The increase in complexity and volume
presents a new level of coordination difficulty for you and for your supply-chain partners worldwide.
Accurately tracking style and order progress, identifying bottlenecks, and sharing data in real-time is
impossible without new tools.

Lawson Fashion PLM Workflow is a powerful web-based software allowing you to view and manage
the global critical path of the entire lifecycle of a product: from planning to design to production to
delivery. With Lawson Fashion PLM Workflow, you allocate, revise, manage, and automatically track
internal and external activities.

All supply-chain partners can see product and order milestones, can receive automatic, configurable
status alerts, as well as update activities or tasks as their access permits.

Seamless integration with Product Manager allows users to complete their daily activities without having
to manually update the workflow.Tasks statuses are linked to Product Manager fields which automatically
updates the critical path as users go about their work.

Lawson Fashion PLM Workflow delivers to your desktop, in real-time, the information that is most
important to you. Full reporting capabilities help you evaluate supplier effectiveness and eliminate
recurrent problems. An enterprise-class solution, Lawson Fashion PLM.

Workflow interfaces seamlessly with transactional systems such as product data management and
enterprise resource planning systems.The result is true end-to-end management of your supply chain.

When setting up Lawson Fashion PLM Workflow, your company will determine the milestones required
to accomplish a certain activity. For example, when a retailer is mapping out its product development
lifecycle, the big picture encompasses such steps as the following:

• Design

• Development

• Production

This is a very general example of a very complex cycle, but the milestones would be time-related, like
this:

Lawson Fashion PLM Workflow User Guide | 5



• Designs have to be decided by March.

• Development must be completed by May.

• Because Production must begin by June.

This is what we refer to as the critical path.

Critical paths can be high level or specific. Depending on the levels you need to drill down to, you may
create different types of paths or flows.

In our example, Design is an activity, as are Development and Production.You can also add
dependencies between activities by linking them into a workflow. In other words, you can define that
Design must be completed before Development can begin, Production depends on the completion of
Development, and so on.

• Market Research

• Line Planning

• Design Approval

When activities grow to encompass more steps and several detailed steps, then you can always make
your activities into workflows.

Any workflow mapping will be a significant undertaking, however with Lawson Fashion PLM Workflow,
you have the option and flexibility to keep it small (one department) and simple (one activity) or make
it as encompassing and complex as your business process warrants.

Once you have created your activity, your next step will be to create the individual tasks required to
complete the activity. Therefore, for the activity Development, the first step could be creating a product
development package using an approved design. This task may be called Product Initiation. The
following tasks could then be:

• Add images, technical sketches, and others.

• Select fabric and trims.

• Define colorways.

• Add measurement specifications.

• Request a proto sample.

Some of the steps would need to be dependent on each other, while others could happen concurrently.
For instance, before a sample can be ordered, a sketch of the design as well as measurements need
to be entered. Defining colors and fabrics could happen before or after the sample is requested. Creating
dependencies for tasks happens at the activity level, while defining dependencies for activities happens
at the workflow level.

When creating tasks, you can define the estimated amount of time required to accomplish the step.
When tasks are linked to activities and workflows, these time estimates are calculated at the higher
level, providing the duration of your workflows.

Throughout your critical paths, you may also need milestones. These will be tasks that don't have a
duration, but can be included within a process as check points. For example, a Fit Sample Approval
can be required before a production run can be requested. If the sample is not approved, another
sample is requested and evaluated.
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Attachments can be associated to activities. When a workflow is created, all users with access to the
attachment will be able to download the file. This is a smart way of keeping related information in one
central location.

Likewise, issues arising around a workflow, activity, or task remain linked through the process. This
ensures that all parties concerned are kept in the loop and tightens communication gaps.

When Lawson Fashion PLM Workflow is used in conjunction with Product Manager, a workflow tab is
available at the product and at the folder level.The contents of this tab are a combination of the workflow
information, as well as overview information for the product. The product design identification allows
users to navigate seamlessly between the workflow and the product. This feature, as well as functions
related to it, are described in the Fashion PLM Product Manager online help.

Key Business Benefits

• Make better, more informed decisions with realtime global information at your fingertips. Staff
receives immediate notification of issues. Priorities can be reassigned automatically. Products
arrive on retail shelves on time with a greater chance of selling at the full retail price.

• Reduce unplanned freight costs. Track the location of products at all times, minimize stock-outs,
and handle complex logistics.

• Resolve problems faster by reviewing only exceptions to your on-time plan. Increased product
visibility and proactive notification reduce the total number of issues to resolve and reduce
communication costs.

• Increase responsiveness, interaction and productivity between you and your supply chain
partners with improved coordination, collection, and sharing of information online with a central
repository. A consolidated view of tasks and partners involved in a critical path improves efficiency.

Features

• Automatic and proactive issue and incident reporting and monitoring to accelerate problem
resolution times and optimize productivity. Issues include sample requests, purchase order
clarification, fault reports, and more. Exception reports ensure easy analysis and generation of key
performance indicators.

• Task scheduling, allocation, and tracking to minimize bottlenecks.Tasks are allocated according
to pre-defined workflow business rules; then are viewable in personal and color-coded priority to-do
lists. Each person involved in a process is kept informed of the progress and due date for their
involvement, and management is notified when tasks escalate to or beyond their due dates.

• Real-time tracking. All activities can be tracked, modified, and scheduled in real time, allowing
you to know and react immediately when issues arise.

• Automatic alerts for milestones that are pending, completed, or overdue to communicate
bottlenecks and to help accelerate time-to-market. Alerts can be emails with links to the specific
task or issue record, SMS text messages, and XML to your PLM (Product Lifecycle Management)
or ERP (Enterprise Resource Planning) systems.

• Customizable rule-based workflow adapts to your environment. Flexible escalation rules are
generated based on your issue and organizational structure.
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• Critical path tracking for individuals, departments and your global organization lets you proactively
reduce supply chain failures. Dynamic links to critical path data residing in your PLM and ERP
systems offer a single integrated view of a style's or of an order's progress.

• Self-help knowledge base stores and organizes documents in a centralized location for easy and
rapid reference.

• Secure, intuitive and centralized contact management through a web browser. Global access
minimizes expensive errors and misunderstandings. Simple, yet configurable, web forms record
all supply chain contact details.

• Flexible real-time pre-defined and ad-hoc reporting to increase your ability to make informed
decisions and to eliminate bottlenecks before they happen. A variety of tools let even non-technical
users report, filter and slice and dice data from any ODBC-compliant databases, not just from
Lawson Fashion PLM Workflow. A range of formats eases analysis and identification of hot spots
and trends.

• Seamless interface with transactional systems such as product data management and enterprise
resource planning systems provides true end-to-end visibility and transparency for your supply
chain.

• Browser-based application, accessible over the web, with security and administration that allows
data and information to be created, viewed, or shared only by authorized users.

Workflow Design

Before beginning a workflow setup, it is a good idea to map out your process. Furthermore, it is
recommended this be done across several departments as processes vary greatly and the more
preparation you do before beginning, the better your workflow will be.

You are ready to build your workflow once you have determined the following:

• The process needed.

• The basic steps.

• The people responsible for doing them.

• The amount of time needed for each step.

• Whether a step should be dependent on or concurrent with another step.

Be sure to identify milestones throughout your process as well as defining which steps need to be
restarted or skipped depending on a result or step status.

Usually, the amount of steps and sub-steps needed will define if your processes should be activities
or workflows. Remember however, that while you can determine dependencies for activities within a
workflow, you cannot define dependencies for workflows. This means that although you can have
several workflows to accommodate your process, there is no way to define that one workflow must be
completed before the next can begin.

Launching Workflow

1 Enter the Product Manager URL in your browser window.
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The Log In page displays.

2 Type your Log In User Name and Password.

3 Click Log In.

The home page displays.

If you cannot launch Product Manager, your User Name and Password may be wrong or your user
status may be inactive. Contact your administrator or try to troubleshoot the login.

Troubleshooting the Login

1 If you have forgotten your password, click Forgot Your Password.

The Forgot Your Password page displays.

2 Type your User Name; then click Continue.

A temporary password is sent to your email address.

3 Return to the Log In page to log in with the temporary password.

The Change Your Password page opens.

4 Enter and confirm a New Password.

5 Click Continue.

The home page displays.

The Home Page
The home page is the starting page for Lawson Fashion PLM Workflow. It contains tabs to the Workflow
sections (Activities, Tasks, Issues) as well as an overview of recent workflows, activities, tasks, and
issues.

The left navigational pane provides access to the workflow structure. The Product Manager structure
is also displayed if you are using Lawson Fashion PLM Workflow with this Product Lifecycle Management
tool.

The main part of the home page lists the workflows, activities, tasks, and issues that were most recently
created or modified over the last three days.

The Home page display is customizable by user and you may select to see recently modified workflows,
activities, tasks, and issues or you may choose to only see recent tasks and issues, or only recent
activities, and others.

Likewise, you determine how many items of each type is displayed on the Home page. If more than
ten were created or modified over the last three days, you will need to view the respective tab to view
all.

Since the recent lists are links, clicking a recently modified activity will open the activity details. This
offers an easy navigation short cut to your workflows, activities, tasks, and issues.

Lawson Fashion PLM Workflow User Guide | 9

Lawson Fashion PLM Workflow



Launching Tasks

On the Lawson Fashion PLM Workflow home page, click the Tasks tab. All the tasks assigned to you
appear. For more information, see "Tasks" on page 26.

Launching Issues

On the Lawson Fashion PLM Workflow home page, click the Issues tab. All the issues you can access
appear. For more information, see "Issues" on page 37.

Working with Folders

1 On the Lawson Fashion PLM Workflow home page, click a folder from the Lawson Fashion PLM
Workflow or from the Product Manager folder lists on the left of the screen.

2 Navigate the folder structure by clicking the + to open any sub-folders.

3 Select a folder from the list.

All workflows within the selected folder are listed by ID.

Selecting Shortcuts

On the Lawson Fashion PLM Workflow home page, click a workflow, activity, a task, or an issue from
the Recent lists. All the information and tabs associated with the workflow, activity, task, or issue appear.

Customizing the Workflow Display

Defining Workflow Display Options

1 Log into Workflow for the first time.

The display options are available.

Tip: Once your display options have been selected they appear by default. To modify them, click
Tools > Customise.

2 Select the recent items you want to display on the Home page.

See "Selecting Recent Lists" on page 11.

3 Select the items you want to display for the File, View, and Tools menu.

See "Selecting Menu Items" on page 11.

4 Click the Home page to view the customized display option.
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Selecting Recent Lists

1 From the Workflow Home page, select the display options:

a Select an item option from the first drop-down list.

b Repeat for all lists.

c Select the number of items to display in the recent lists.

2 Click Save.

The changes are displayed.

Selecting Menu Items

1 From the Workflow Home page, click the Menu tab.

The menu option appears.

2 Select the check boxes of the items you want to make visible in the workflow menus.

Tip: Unchecked boxes will be hidden.

3 Click Save.

The changes are displayed the next time you log into Workflow.
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2Workflow

Overview
Workflows are the series of activities and tasks that constitute your critical path. By identifying the
various activities of your business you can effectively track your business process, identify strengths
and weaknesses, and better manage resources and allocation.

Workflows are the high level critical paths that are comprised of more specific activities. Create
dependencies between activities and define them as Default or Mandatory to automatically manage
the flow of activities throughout your process.

Workflows are stored in the Workflow folders. Depending on your company hierarchy, they could be
stored by seasonal level, by division, by department, and others. For each created folder, a Template
folder also exists. All workflow templates are stored in the template folders.

Viewing a Workflow

1 From the Workflow folder, click the ID link.

The Workflow details page opens.

Tip: You may also click the workflow name in the Recent Workflows list on the Home page to open
a workflow.

2 Click the Activity tab to view all activities for this workflow.

See "Workflow Activities" on page 17.

3 Click the Chart tab to view a visual bar chart of Activities and their dependencies.

See "Chart" on page 36.

4 Click the Issue tab to view any comments or issues associated to the workflow.

See "Workflow Issues" on page 18.

5 Click the Attachments tab to view any files attached to the workflow.

See "Workflow Attachments" on page 18.

6 Click the Notifications tab to view any notifications linked to the workflow.

See "Workflow Notifications" on page 19.
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Creating a Workflow

1 From a workflow page, click File > New > Workflow.

The Workflow page opens.

2 Select a folder for the Workflow:

a Click the Directory icon to open the folder structure.

b Use the + and - to navigate to the desired folder and select a folder.

c Click OK.

The folder path is selected as a Directory.

Tip: The Directory will be preselected if you click Add Workflow from a workflow folder view.

3 Type a name in the Description field.

4 To schedule the workflow from an End Date, click the Schedule from End check box.

Note: The Schedule from End check box toggles the date box between Due Start to Due End.

5 Select a Due Start date from the calendar.

-or-

Select a Due End date from the calendar.

6 Select your standard week options:

a Select a Work Start from the list.

b Select a Day Start from the list.

c Select a Work End from the list.

d Select a Work End from the list.

e Select a Day End from the list.

7 You may add thumbnail images for this workflow.

See "Adding Images" on page 13.

8 Click Save.

The Activity, Chart, Issue, Attachments, and Notifications tabs appear.

Adding Images

1 From the Thumbnails section of the Workflow or Activity page, click Browse.

2 Select an image from your disk and click Open.
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A successful message appears and a thumbnail view of this image is added to the workflow.

3 You may click the image to open the zoom window.

See "Zooming In On Images" on page 14.

4 You may download images by clicking the Download link.

See "Downloading Images" on page 14.

5 Click Save.

Zooming In On Images

1 From the Thumbnails section of a workflow or activity, click the image.

The Zoom Image window opens.

2 Select a Zoom % from the list, then click Refresh to view the image at the selected magnification
percentage.

Tip: You may also use the + or - magnifying tools to zoom in and out.

3 Use the scroll arrows to pan the image.

4 Click the Close Window link to close the Zoom window.

Downloading Images

1 From the Thumbnails section of a workflow or activity, click the Download link.

The File Open or Save message appears.

2 Click Save.

The Save As window opens.

3 Select the location where you want to save this attachment, then click Save.

The image is saved to the selected location.

Scheduling Workflows

From the workflow details page, click Schedule. The workflow is scheduled either from the Due Start
date or from the Due End date. The percentage complete is automatically tracked as tasks are
completed.

Once a workflow is scheduled, you cannot unscheduled or delete it; you can only deactivate the
workflow.
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Saving a Workflow as a Template

1 From the workflow details page, click Save as Template.

A confirmation message appears.

2 Click OK.

The workflow is saved to the Template folder. All dates are removed from the template.

Adding Workflow from Templates

1 From a workflow page, click File > New > Workflow from Template.

The Workflow structure opens.

2 Select a folder from the list.

All available templates are listed.

3 Select a workflow template and click OK.

The workflow is created and all template information is available.

Setting a Workflow Baseline

1 From the Workflow page of a scheduled workflow, click Set Baseline.

The Baseline message appears.

2 Click OK.

The Baseline Date and Reason fields appear. By default, the current date is automatically added
to the Date field.

3 You may select a different date from the calendar by clicking the field.

4 Type a Reason in the field.

5 Click OK.

The Baseline is created and the Start and End dates are added.The Baseline History automatically
tracks any Baseline activity.

Deactivating a Workflow

1 From the Workflow details page, click Deactivate.

A confirmation message appears.

2 Click OK.

The workflow is deactivated. Deactivated workflows are not visible from the folder view.You may
click the view icon to display deactivated workflows.
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Tip: You may reactivate workflows at any time. See "Reactivating a Workflow" on page 16.

Reactivating a Workflow

1 From the workflow folder, click the Display Deactivated Workflow icon.

All deactivated workflows are displayed.

2 Click the ID to open the workflow details page.

3 Click Activate.

A confirmation message appears.

4 Click OK.

The workflow, it's activities, and tasks are activated.

Copying a Workflow

1 From the Workflow details page, click Copy.

The Workflow structure window opens.

2 Select a folder from the list and click OK.

The copied workflow's detail page opens.

3 Type a name for the copied workflow.

By default the Description field will contain "Copy of ...".

4 Click Save.

The workflow is copied to the selected folder.

Deleting a Workflow

1 From a workflow folder, select the workflow you want to delete and click Delete.

A confirmation message appears.

Note: A Scheduled, Completed, Failed or Cancelled workflow can not be deleted.

2 Click OK.

The workflow is removed from the list.
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Workflow Activities

Viewing Workflow Activities

1 From the Workflow page, click the Activity tab.

All activities are listed.

2 Click the ID link to view the Activity details.

See "Activities" on page 19.

Adding Workflow Activities

1 From the Activity page, click Add Activity.

The new Activity page opens.

2 Select a Season from the list.

3 Type a name for the activity in the Description field.

4 Select a Category from the list.

5 Enter the Repetition for this activity.

6 Click the Owner arrow and click Select.

The list of Owners window opens.

• Select a user from the list.

The user's name appears in the Owner field.

Note: If the activity has the Mandatory dependency with its predecessors being incomplete, the
owner (or an Administrator) may start the activity out of sequence.

7 Click the Reminder field and select a date from the calendar.

Tip: You may also type the time you want the notification to be sent for the reminder.

8 You may add thumbnail images for this activity.

See "Adding Images" on page 13.

9 Click Save.

The Task, Chart, Issues, Attachments, and Notifications tabs appear. For more detailed Activity
procedures, see "Activities" on page 19.
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Workflow Issues

Viewing Workflow Issues

1 From a workflow page, click the Issues tab.

The Issue page opens and all issues are listed.

2 Click the ID to open the Issue details.

Adding Issues for Workflows

1 On the Workflow page, click the Add Issue icon.

The new Issue page opens.

2 Select the following information to complete the issue:

• Deliverable

• Issue Type

• Locations

• Category

• Other (Location)

• Reason

• Other (Reason)

3 Enter a descriptive message for the issue in the Notes field.

4 Click Report. The issue is created and appears.

5 Click Save.

The Issue is added to the workflow.

6 You may change the issue status, add files to it, copy, delete or deactivate the issue.

See "Processing Issues" on page 38.

Workflow Attachments

Viewing Workflow Attachments

1 From a workflow page, click the Attachments tab.

The Attachments page opens.
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2 Click the attachment ID to view the attachment.

The Attachment opens in a different window.

Adding Attachments for Workflows

For more information, see "Attachments" on page 39.

Workflow Notifications

Viewing Workflow Notification

1 From a workflow page, click the Notifications tab.

The Notifications page opens.

2 Click the ID to view the notification details.

See "Notifications" on page 41.

Adding Notifications for Workflows

See "Adding Notifications" on page 41.

Activities
Since creating activities can be time consuming, workflow templates enable you to define specific or
general activities that you can reuse. This is a huge time saver and when used effectively can ensure
that all activities are set up using the same model, making reporting easier to manage.

You may also use Library as a storage place for activities and tasks, ensuring that these process may
be added at all times without the need to recreate or copying.

When setting up activity dependencies, you have the option of creating different types of dependencies:

• Default - the activities are linked but the successor may be started before the Predecessor is
completed.

• Mandatory - the Predecessor activity must be completed before the successor activity can begin.

A system of notifications can be set up to ensure everyone is kept informed of who is responsible for
each activity as well as activity progress.
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Viewing Activities

1 From a workflow page, click the Activities tab.

All activities are listed.

Tip: You may also click the activity name in the Recent Activities list on the Home page to open an
activity.

2 Click the ID link to open the Activity details page.

3 Click the Task tab to view all tasks for this activity.

See "Activity Tasks" on page 24.

4 Click the Dependencies tab to view the dependencies for this activity.

See "Activity Dependencies" on page 24.

5 Click the Chart tab to view a visual bar chart of tasks and their dependencies.

See "Chart" on page 36.

6 Click the Issue tab to view any comments or issues associated to the activity.

See "Activity Issues" on page 24.

7 Click the Attachments tab to view any files attached to the activity.

See "Activity Attachments" on page 25.

8 Click the Notifications tab to view any notifications linked to the activity.

See "Adding Notifications" on page 41.

Creating a New Activity

1 From the workflow Activity page, click Add Activity.

The new Activity page opens.

2 Select a Season from the list.

3 Type a name for the activity in the Description field.

4 Select a Category from the list.

5 Enter the number of Repetition for this activity.

If the activity fails, it can be repeated several times so that it can succeed.

6 Add an owner for the activity:

a Click the Owner arrow and click Select.

The Owners window opens.

b Select a user from the list.
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The user's name appears in the Owner field.

Note: If the activity has the Mandatory dependency with its predecessors being incomplete, the
owner may start the activity out of sequence.

7 Click the Reminder field and select a date from the calendar.

Tip: You may also type the time you want the notification to be sent for the reminder.

8 You may add thumbnail images for this activity.

See "Adding Images" on page 13.

9 Click Save.

The Task, Chart, Issues, Attachments, and Notifications tabs appear.

Adding Dependent Activities

1 From the Activity page, click Next Activity to add a dependent activity.

2 Select a dependency type:

• Default - the activities are linked but the successor may be started before the Predecessor is
completed.

• Mandatory - the Predecessor activity must be completed before the successor activity can
begin.

3 Add the activity information and click Save.

Adding Activities from the Library

1 From the Activities page of a workflow, click Activities > to open the Activities menu and select
Retrieve from Library.

The Library structure opens.

2 Select a template folder from the list.

All Activity templates are displayed.

3 Select an activity template from the list and click OK.

The activity is added to the workflow.

Note: You may select more than one template.

4 Click Save.
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Copying Activities from Other Workflows

1 From the Activities page of a workflow, click Activities> to open the Activities menu and select Copy
From.

The Workflow structure window opens.

2 Select a workflow folder from the list.

All workkflow activities are listed.

Note: Only activities for other workflows than the current one are shown.

3 Select the desired activity or activities and click OK.

The selected activity is added t the workflow.

Copying Activities

1 From the Activity page, select the activity you want to copy.

2 Click Activities> to open the Activities menu and select Copy To.

The copy option dialog box opens.

3 Select a copy option:

a Click OK to copy the activity to an existing workflow.

The Workflow structure opens.

b Select a workflow folder.

All available workflows are listed.

c Select a workflow and click OK.

The activity is copied to the selected workflow.

-or-

Click New to create a new workflow and copy the activity to it.

See "Creating a Workflow" on page 13.

4 Click Save.

Saving an Activity as a Template

1 From the Activity page, click Save to Library.

The Library structure window opens.

2 Select a folder where the activity template will be stored and click Save.
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A confirmation message appears.

Tip: You may also select multiple activities from the workflow Activity page and click Activity >
Save to Library.

3 Click OK.

Deactivating an Activity

1 From the Activity page, select the activity to be deactivated.

2 Click Deactivate.

A confirmation dialog displays.

3 Click OK.

Deactivate activities are not displayed from active lists.

Tip: You may reactivate activities at any time. For more information, see "Reactivating an Activity" on
page 23

Reactivating an Activity

1 From the Activity page, click Activities > Display Deactivated Activities.

All deactivated activities are displayed.

2 Click the ID to open the activity details page.

3 Click Activate.

A confirmation message appears.

4 Click OK.

The activity is reactivated.

Deleting an Activity

1 From the Activity page, select the activity you want to delete.

2 Click Activities > Delete.

A confirmation message appears.

3 Click OK.

The activity is deleted and a successful message is displayed.

4 Click OK.
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Caution: This action is permanent and may not be undone.

Activity Tasks

Viewing Activity Tasks

From any activity page, click Task tab. The activity task list displays.

Tasks can be color-coded for at-a-glance identification of criticality and level of escalation. Contact
your administrator for a definition of priority levels.

Note: When the check box beside the task is greyed-out, the task is linked to Product Manager. When
the check box is active, the task can be edited on this page. See "Updating Tasks" on page 30.

Adding Tasks for an Activity

See "Creating a New Task" on page 27.

Activity Dependencies

Viewing Activity Dependencies

From any activity page, click Dependencies tab. The Predecessor and Successor list appear.

Adding Dependencies for Activities

See "Adding Dependencies" on page 35.

Activity Issues

Viewing Activity Issues

From any activity page, click Issues tab. Issues list appear.
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Adding Issues for Activities

1 On the Activity page, click the Add Issue icon.

The new Issue page opens.

2 Select the following information to complete the issue:

• Deliverables

• Issue Type

• Locations

• Category

• Other (Location)

• Reason

• Other (Reason)

3 Enter a descriptive message for the issue in the Notes field.

4 Click Report.

The issue is created and appears.

5 Click Save.

The Issue is added to the activity.

6 You may change the issue status, add files to it, copy, delete or deactivate the issue.

See "Processing Issues" on page 38 for details.

Activity Attachments

Viewing Activity Attachments

1 From an activity page, click the Attachments tab.

The Attachments page opens.

2 Click the attachment ID to view the attachment.

The Attachment opens in a different window.

Adding Attachments for Activities

See "Attachments" on page 39.
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Activity Notifications

Viewing Activity Notifications

1 From an activity page, click the Notifications tab.

The Notifications page opens.

2 Click the ID to view the notification details.

See "Notifications" on page 41.

Adding Notifications for Activities

See "Adding Notifications" on page 41.

Tasks
Workflow tasks are the basic component of this application. Whether your company is using Workflow
as a stand-alone tool or linked to Product Manager, tasks are the everyday operations you perform in
the completion of your duties.

Some tasks are handled by individuals, while some may be divided amongst a group. Determining
resource allocation for tasks is an important aspect of the workflow set up.

In order to group related tasks effectively, an activity is created with its set of notifications, issues, and
attachments. There are four tabs available for every task in the workflow:

• Task - This tab includes information about what the task is and who is responsible for its completion,
as well as task status.

• Dependencies - This tab allows you to view and define task dependencies.

• Issues - This tabs lists all issues associated to the task and allows you to link other issues to the
task.

• Attachments - All files associated with this task and attached to it can be accessed from this tab.

• Notifications - All notifications defined for this task are listed in this tab.You can edit, add or
remove notifications.

Managing your tasks when working with Workflow is easy and fast. Some tasks can be linked to Product
Manager and these are updated automatically as they are performed. Keeping your task list updated
ensures that all teams working with you are kept informed of your progress and maintains the integrity
of the workflow.

When setting up task dependencies, you have the option of creating different types of dependencies:

• Default - the tasks are linked but the successor may be started before the Predecessor is completed.

• Mandatory - the Predecessor task must be completed before the successor task can begin.
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A system of notifications can be set up to ensure everyone is kept informed of who is responsible for
each task as well as when tasks reach progress milestones such as completion.

Notifications are not the same as issues. Issues are problems that arise as you execute your tasks.
These issues are reported and a predefined set of rules determines the issue recipients.

Viewing Tasks

1 From a Activities page, click the Tasks tab.

All tasks are listed.

Tip: You may also click the task name in the Recent Tasks list on the Home page to open a task.

2 Click the ID link to open the Task details page.

3 Click the Dependencies tab to view the dependencies for this task.

See "Task Dependencies" on page 33.

4 Click the Issue tab to view any comments or issues associated to the task.

See "Task Issues" on page 33.

5 Click the Attachments tab to view any files attached to the task.

See "Task Attachments" on page 34.

6 Click the Notifications tab to view any notifications linked to the task.

See "Task Notifications" on page 34.

Displaying Your Task List

1 From the Home page, click the Tasks tab.

All tasks assigned to you are listed.

2 You may sort the list or click a specific task ID to open it.

Note: Tasks can be color-coded for at-a-glance identification of criticality and level of escalation.
Contact your administrator for a definition of priority levels.

Creating a New Task

1 From the activity Tasks page, click Add Task.

The new Task page opens.

Tip: You can also click Next task to add a new task.
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2 Type a Description in the field.

This field is required.

3 Select a Status from the list:

• Not Started - indicates any pre-condition of current task is not yet ready

• Ready to Start - indicates that all dependent tasks are completed.

• Started - the task is in progress.

• Overdue - indicates that the current task is overdue. A task's overdue status is automatically
determined by Due End date.

• Completed - indicates that the current task is completed successfully. Its successors will be
changed to 'Ready to start' if there is no other predecessor.

• Failed - indicates that the current task failed to complete. It can never be modified and remains
as a reference only.

• Cancelled - indicates that the current task has been cancelled. It can never be modified and
remains as a reference only.

4 Select a team responsible for the Ownership of this task.

See "Defining Ownership for a Task" on page 29.

5 Add an owner for the task:

a Click the Owner arrow and click Select.

The list of Owners window opens.

b Select a user from the list.

The user's name appears in the Owner field.

Note: If the task has the Mandatory dependency with its predecessors being incomplete, the
owner may start the task out of sequence.

6 Select users to assign to this task.

See "Allocating Resources to a Task" on page 30.

7 Click the Milestone check box to make this task a milestone.

The duration and end date options will be removed from the task.

8 Select a Type from the list.

9 Click the Reminder arrow to open the calendar and select a date, then type a send-time for the
reminder.

Note: A send-time must be entered for the reminder.

10 Select a Category from the list.
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11 Enter the number of Repetition for this task.

If the task fails, it can be repeated several times so that it can succeed.

12 Select a percentage from the % Complete list.

The percentage field displays 100% when the status is Completed.

13 The Due Start and Due End dates are empty until the workflow is scheduled.

14 Add time information:

a Click the Actual Start arrow to open the calendar and select a date.

The Actual Duration is calculated.

b When your task has been completed, click the Actual End arrow to open the calendar and select
a date.

The Status changes to Completed.

Note: The Actual End date cannot be a future date. Once the Status changes to Completed,
Failed, or Cancelled the Actual End is automatically filled with the current date.

c Type the time it will take to accomplish this task in the Estimated Duration field.

d Type the amount of time during which the task can be accomplish in the Estimated Working
Duration field.

Note: The Estimated Duration indicates the actual time needed to do the task (5 hours), while
the Estimated Working Duration indicates that time during which the task can be completed
(1h/day for 5 days = 1 week)

e Select a unit of time from Man Hours, Man Days, Man Weeks, and Man Years.

f When your task has been completed, type the number of hours or days it actually took to
accomplish this task in the Actual Working Duration field.

g Select a unit of time from Man Hours, Man Days, Man Weeks, and Man Years.

15 Type your comments in the Additional Notes field.

Once saved, these display in the History box in read-only format.

16 Click Save.

Defining Ownership for a Task

1 Click one of the Select Users icons to open the Select Users window.

• Select Title - a list of Titles for users is available.

• Select Business Partner - a list of Business Partners is available.
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2 Select titles or Business Partners in the Available list, then click Add> to move them to the Selected
list.

Tip: You can add all available titles or Business Partners to the selected list by clicking Add All>>.
You can remove all names from the selected list by clicking <<Remove All.

3 Click OK to save your selection.

Allocating Resources to a Task

1 Click one of the Select Users icons to open the Select Users window.

• Select Users - a list of users is available

• Select User Groups - a list of user groups is available

2 Select users or user groups in the Available list, then click Add> to move them to the Selected list.

Tip: You can add all available users or groups to the selected list by clicking Add All>>.You can
remove all names from the selected list by clicking <<Remove All.

3 Click OK to save your selection.

Updating Tasks

1 From the list of tasks, click the Description field and modify the task's name.

Tip: You may also select several tasks and choose a Status option from the Tasks> menu.

2 Select a Status from the drop-down list.

3 Continue modifying your task information.

Note: See "Creating a New Task" on page 27 for more information about tasks.

4 Click Save.

Copying Tasks from Other Workflows

1 From the Tasks page of an activity, click Tasks > Copy From.

The Workflow structure window opens.

2 Select a workflow folder from the list.

All workflows, their activities and tasks are listed.
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Note: Only activities for workflows other than the current one are shown.

3 Select the desired task(s) and click OK.

The selected task is added to the workflow.

Copying Tasks to an Existing Activity

1 From the Task page, click Copy.

The copy option dialog box opens.

2 Click OK.

The Workflow structure opens.

3 Select a workflow folder.

All available activities are listed.

Tip: The * identifies those activities that are part of Workflow templates.

4 Select an activity and click OK.

The task is copied to the selected activity.

Tip: You may also click New to create a new activity in an existing workflow and copy the task to
it. See "Copying a Task to a New Activity" on page 31.

5 Click Save.

Copying a Task to a New Activity

1 From the Task page, click Copy.

The copy option dialog opens.

2 Click New.

The Workflow structure opens.

3 Select a workflow folder.

All available workflows are listed.

4 Select a workflow and click OK.

The new Activity page opens.

5 Add activity information.

See "Creating a New Activity" on page 20.
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6 Click Save.

The task is copied to the new activity.

Saving a Task as a Template

1 From the Task page, click Save to Library.

The Library structure window opens.

2 Select a folder where the task template will be stored and click Save.

A confirmation message appears.

Tip: You may also select multiple tasks from the activity Tasks page and click Tasks > Save to
Library.

3 Click OK.

Deactivating Tasks

1 From the Task detail page, click Deactivate.

A confirmation message appears.

2 Click OK.

Deactivate tasks are not displayed from active lists.

Tip: You may reactivate tasks at any time. See "Reactivating a Task" on page 32.

Reactivating a Task

1 From the Tasks page, click Tasks > Display Deactivated Tasks.

All deactivated tasks are displayed.

2 Click the ID to open the task details page.

3 Click Activate.

A confirmation message appears.

4 Click OK.

The tasks is reactivated.
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Deleting a Task

1 From the Task page, select the task you want to delete.

2 Click Tasks > Delete.

A confirmation message appears.

3 Click OK.

The task is deleted and a successful message is displayed.

4 Click OK.

Caution: This action is permanent and may not be undone.

Task Dependencies

Viewing Task Dependencies

From any task page, click Dependencies tab. The Predecessor and Successor list appear.

Adding Dependencies for Tasks

See "Adding Dependencies" on page 35.

Task Issues

Viewing Task Issues

1 From an task page, click the Issues tab.

The Issue page opens.

2 Click the ID to open the Issue details.

See "Issues" on page 37 for details steps and procedures.

Adding Issues for Tasks

1 On the Task page, click the Add Issue icon.

The new Issue page opens.
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2 Select the following information to complete the issue:

• Deliverables

• Issue Type

• Locations

• Category

• Other (Location)

• Reason

• Other (Reason)

3 Enter a descriptive message for the issue in the Notes field.

4 Click Report.

The issue is created and appears.

5 Click Save.

The Issue is added to the task.

6 You may change the issue status, add files to it, copy, delete or deactivate the issue.

See for details.

Task Attachments

Viewing Task Attachments

From a task page, click the Attachments tab. The Attachments page opens.

Click the attachment ID to view the attachment. The Attachment opens in a different window. See
"Attachments" on page 39.

Adding Attachments for Tasks

For more information, see "Attachments" on page 39.

Task Notifications

Viewing Task Notifications

1 From a task page, click the Notifications tab.
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The Notifications page opens.

2 Click the ID to view the notification details.

See "Notifications" on page 41.

Adding Task Notifications

For more information, see "Adding Notifications" on page 41.

Dependencies
The Dependencies page allows you to view and add dependencies between your activities when on
a workflow, or between tasks when viewing activities.

When setting up dependencies, you have the option of creating different types of dependencies:

• Default - the activities or tasks are linked but the successor may be started before the Predecessor
is completed.

• Mandatory - the Predecessor activity or task must be completed before the successor activity or
task can begin.

Whether viewing Dependencies for activities or tasks the processes are the same.

View Dependencies

From a activities or tasks page, click the Dependencies tab. The Predecessor and Successor list
appear.

Adding Dependencies

1 From the Dependencies page of a activities or tasks, click Predecessors > Select to make the
current activity/task dependent on a previous activity/task. The Dependencies window opens.

a Select the desired activity or task and click Select.

b Select a dependency type:

• Default

• Mandatory

c Click OK.

2 To make the current activity or task dependent on a previous activity/task, click Successors >
Select.

The Dependencies window opens.
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3 Repeat step 2.

The activity is listed in the Successors list.

4 Click Save.

Removing Dependencies

1 From the Dependencies page, select one or more activity/task from the Predecessors or the
Successors list that you want to remove.

2 Click Predecessors > Remove.

The Predecessor activity/task is removed.

-or-

Click Successors > Remove.

The Successor activity/ task is removed.

3 Click Save.

Chart
The Chart page is available for workflows and activities. It provides a graphical representation of your
activities or tasks, their durations and dependencies. The Chart also provide a quick navigational tool
allowing you to drill down from your activities to the task details.

Viewing the Workflow Chart

1 From a workflow page, click the Chart tab.

The Chart page opens.

2 Click the activity link to open the activity Chart page.

3 Click the task link to open the task details page.

Viewing the Activity Chart

1 From the activity page, click the Chart tab.

The Chart page opens.

2 Click the task link to open the task details page.
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Issues
Workflow issues are records of any problems that arise during the completion of a workflow activity or
task.They are the kinds of communication that usually take place in emails, in hallways, over the phone,
or on company memos. By using the Issue feature in Workflow, your company can keep these
communications centralized.

Furthermore, since they are kept in one place and linked to activities or tasks, you eliminate duplication,
keep track of history, and ensure that everyone has the same information. Issues allow you to tighten
or, in best cases, eliminate communication gaps between teams, companies, and business partners.

Issues can only be added from Workflows, Activities and Tasks.The Issue tab available in all Workflows,
Activities and Tasks displays all issues linked to them. Each issue can also be linked to various
Workflows, Activities and Tasks using the Activity & Attachments page. Available on this page are all
files linked to an issue.

Displaying Issues List

1 From the Home page, click the Issues tab.

All issues you have access to are listed.

2 You may sort the list or click a specific task ID to open it.

Viewing Workflow Issues

1 From a workflow page, click the Issues tab.

The Issue page opens and all issues are listed.

2 Click the ID to open the Issue details.

Viewing Activity Issues

1 From an activity page, click the Issues tab.

The Issue page opens.

2 Click the ID to open the Issue details.

Viewing Task Issues

1 From an activity page, click the Issues tab.

The Issue page opens.

2 Click the ID to open the Issue details.
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Adding New Issue

For more information, see "Adding Issues for Workflows" on page 18, "Viewing Activity Issues" on
page 24 and "Adding Issues for Tasks" on page 33.

Processing Issues

1 From the Issue details page, use the icons at the top of the page to process the issue.

a Change the Status:

• Acknowledge

• Hold

• Close

b Archive the issue:

• Archive

c Add attachments:

• Files - see "Adding Files" on page 40.

d Manage the issue:

• Copy - copy the issue and link it to a different workflow, activity, or task.

• Delete - permanently remove the issue.

• Deactivate - remove the issue, while keeping a record of it.

2 Click Save.

Archiving Issues

1 From the Issue page, click Archive.

A confirmation message appears.

2 Click OK.

Deleting Issues

1 From the Issue page, click Delete.

A confirmation message appears.

2 Click OK.

3 From the issue, click Delete.
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Viewing Activities and Attachments for an Issue

1 From the Issue detail page, click the Activity & Attachments tab.

The associate Tasks, Activities, Workflows, and Attachments appear.

2 You may view the linked Tasks, Activities, Workflows or Files by clicking their ID links.

Linking Issues

1 From the Issues page of a workflow, activity or task, click Issues > Select.

The list of issues opens.

2 Click the issue you want to link.

The issue is added to the list.

3 Click Save.

Unlink Issues

1 From the issues list, select the issue you want to remove.

2 From the arrow beside Issues > Remove.

3 Click Save.

Attachments
Attaching files to your workflows, activities, tasks, or issues is a great way to keep information centralized
and ensure that everyone can access the same version of your files.

From the Attachments page, you can add new files, edit existing file details, add folders for attachments,
as well as delete files.

Whether you are viewing the Attachment tab from a workflow, activity, task, or issue, the processes
are the same.

Viewing Attachments

1 From a workflow, activity, task, or issue page, click the Attachments tab.

The Attachments page opens.

2 Click the attachment ID to view the attachment.

The Attachment opens in a different window.
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Adding Files

1 From the Attachments page of a workflow, activity, or task, click Files.

The Attachments page opens.

2 Click Add file.

The new Attachments page opens.

3 Click Browse to select a file from your disk.

4 Click Open.

The file path appears in the File field and the File Name appears in the field.

5 Type a new name for the attachment in the File Name field.

6 Type a Description for the attachment.

7 Select an Expires date from the calendar.

8 Type your comments in the Additional Notes field.

Once saved, these comments appear as read-only in the Notes field.

9 Click Upload to attach the file.

The file appears in the Attachments list.

Editing File Details

1 From the Attachment list, select the file you want to edit.

2 Click Edit Details.

The file details page opens.

3 Modify the information.

4 Click Save.

Adding Folders

1 From the Attachment list, click Add Folder.

The New Folder page appears.

Note: Add Folders for your issues to sort issues by type or to make issues private.

2 Type a name for the folder in the field.

3 Click the Private check box if you do not want the folder to be shared with other users.

4 Click Add.

The Folder is created.
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5 You may add issues to your folder by opening the folder and clicking Add File.

See "Adding Files" on page 40.

Deleting Files

1 From the Attachment list, select the file(s) or folder(s) you want to remove.

2 Click Delete.

A confirmation message appears.

3 Click OK.

The File or folder is deleted.

Caution: Deleting folders will delete all issues in it. This action may not be undone.

Notifications
The notifications feature sends pre-set email messages to recipients that you specify to alert them of
the status of your workflows, activities, or tasks.

Notifications can either be set up while an activity or a task is being created or they are added later.

Viewing Notifications

1 From a workflow, activity, or task page, click the Notifications tab.

The Notifications page opens.

2 Click the ID to view the notification details.

Adding Notifications

1 From a workflow, activity, or task page, click Add Notifications.

The new Notifications page opens.

2 Select a notification status from the Notification Option list.

3 Select recipients to add to the Send list.

See "Selecting Notification Recipients" on page 42.

4 Type the interval at which you want the notification to be sent in the Interval field:

Lawson Fashion PLM Workflow User Guide | 41

Workflow



• Leaving Interval blank sends the message once the condition is met.

• Entering 1 Day sends the message one day after the condition is met.

• Entering -3 Days sends the message three days before the condition is met, and others.

5 Select users to add to the Ownership list.

6 Enter your message text in the Message field.

7 Click Save.

Selecting Notification Recipients

1 From the Notifications page, click one of the Select Users icons to open the Select Users window.

• Select Users - a list of users is available

• Select User Groups - a list of user groups is available

2 Select users or user groups in the Available list, then click Add> to move them to the Selected list.

Tip: You can add all available users or groups to the selected list by clicking Add All>>.You can
remove all names from the selected list by clicking <<Remove All.

3 Click OK to save your selection.

Removing Notifications

1 From the Notifications page of a workflow, activity, or task, select the notifications you want to
remove.

2 Click the Delete icon.
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